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How to optimize JPEG images 
JPEG (Joint Photograph Experts Group) is a graphical file format best used for photographs or for images with 
subtle changes in color, gradations, or lighting. With Adobe Fireworks CS3, you can compare different versions of 
the same graphic to create the best quality with the smallest file size. Before optimizing, complete the graphic (size, 
effects, color, design). 

Optimize a JPEG image 

1. Open the completed graphic in Fireworks. 

2. In the Optimize panel, select JPEG from the Export File 
Format menu. 

3. Select the 4-Up button to compare different versions of 
the image.  

 Make sure the image is visible in the display area 
(Figure 1). (If necessary, use the Hand tool to drag the 
image into the middle.) 

4. Use the Pointer tool to select in turn each of the three 
alternate versions of the original image, and try different 
settings in the Optimize panel to find the smallest file 
size with the most acceptable quality.  

• From the Settings menu, select JPEG – Better 
Quality or JPEG – Smaller File for preset quality 
values. 

• Try different values for the Quality setting. 

• To make the file smaller, increase the Smoothing. 

 As you try different settings, note the file size and 
download time for each quality level. 

5. To export the image version you prefer, click it and 
select File > Export. Name the file with a .jpg extension.

6. To save the richest version of the file, select File > Save 
As and save the file as a Fireworks PNG file (with a 
.png extension). 

 

Figure 1 Comparing JPEG images 

 

 

4-Up button 
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Use a JPEG mask for further optimization (optional) 
You can further optimize the size of a graphic by selecting a specific area of the image and changing its quality 
setting. 

1. Click the Original button to return to the (single) 
original image. 

2. Using the Marquee tool, outline the point of interest in 
your image. 

3. With the point of interest selected, choose Select > 
Select Inverse.  

 This selects everything except the point of interest of the 
image. A marquee surrounds the inverse selection 
(Figure 2). 

4. To make changes only to the region outside the point of 
interest, select Modify > Selective JPEG > 
Save Selection As JPEG Mask.  

 A highlight color appears on everything except the point 
of interest of the image. 

 In the Optimize panel, you can now make changes to the 
value for Selective Quality. Reducing this number 
retains the image quality of the point of interest but 
reduces the quality of the background and thereby 
reduces the file size.  

5. Click the Preview button to see the effect of your 
changes. 

Figure 2 Inverse selection 

 

 



Adobe Fireworks CS3 Activity 1.5 worksheet 

© 2007 Adobe Systems Incorporated Fireworks tools 1 

Fireworks tools 
Student name: ________________________________________________ Date: _______________________ 

The Tools panel in Adobe Fireworks CS3 contains the main tools to create and modify images. 

 

Identify the selection, movement,  
and transformation tools: 

 

 

Identify the image modification tools: 

 
 
 

 

 

Identify the drawing and writing tools: 

 

 

 

Identify the interactive objects tools: 

 
 
 

Identify the color tools: 

 

 

 

 

Identify the view tools: 
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Fireworks panels 

Floating and docked panels 
Panels provide easy access to controls that help you edit selected objects or elements of a document in Adobe 
Fireworks CS3. You can use panels to work on frames, layers, symbols, color swatches, and more. Each panel can 
be dragged, so you can group panels together in custom arrangements. By default, the panels are docked to the right 
side of the workspace. You can undock panel groups, add panels to a group, undock individual panels, rearrange the 
order of docked panel groups, and collapse and close panel groups. To undock a panel, drag the panel gripper in the 
upper left corner of the panel’s title bar. Many of the panels are tabbed, with two or more panels combined. 

Tools panel 
The Tools panel (Figure 1) is organized into clearly labeled sections for easy tool selection. If the Tools panel is not 
visible, you can display it by selecting Window > Tools. To select a tool, just click it or use the shortcut key shown 
in parentheses. If a tool has a small black triangle in the bottom right corner, it is part of a group of tools; move the 
pointer to the tool, and then click and hold down the mouse button to access the pop-up tool group. 
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Selection, movement, and transformation 
tools: 

Pointer tool (black arrow): Click an object to 
select it. Drag a selected object to move it. 

Scale tool: Enlarge or reduce an object, rotate, 
flip, distort, or skew objects or groups. 

Subselection tool (white arrow): Select and 
move points of an object or edit paths between 
adjacent points. 

Crop tool: Remove the part of an image outside 
a selected rectangular region. 

Drawing and writing tools: 

Line tool: Draw straight lines. 

Rectangle tool: Draw rectangles. Click and hold 
the small arrow at the bottom right to select a 
different shape to draw. 

Freeform tool: Draw freeform shapes. 

Pen tool: Click to place points; the Pen tool 
connects successive points with straight lines. 
Drag a point to form a curve. 

Text tool: Type text. 

Knife tool: Cut a path in two or more paths. 

Interactive objects tools: 

Rectangle Hotspot tool: Draw a special area on 
top of an image that can be clicked to link to a 
new web page. 

Hide Slices And Hotspots: Hide all slices and 
hotspots drawn on an image. 

Slice tool: Draw slice areas on an image to 
enable user interaction with the image on a web 
page. 

Show Slices And Hotspots: Show all slices and 
hotspots drawn on an image. 

View tools: 

Three top icons: Standard Screen mode, Full 
Screen With Menus mode, or Full Screen mode. 

Hand tool: Move the visible portion of an 
image without using the document scroll bars. 

Zoom tool (magnifying glass): Zoom in or out 
for a closer or farther view of an image. 

 

 
 

Figure 1 
Tools panel 

Image modification tools: 

Marquee tool: Select a rectangular region 
of pixels. Press and hold the small arrow at 
the bottom right to select a different shape 
for your selection tool. 

Magic Wand tool: Select pixels of a similar 
color. 

Pencil tool: Draw a bitmap line with a 1-
pixel stroke. 

Blur tool: Blur the focus of parts of an 
image. 

Lasso tool: Similar to Marquee tool, but 
lets you freeform-select an area of pixels. 

Brush tool: Select from a variety of brush 
strokes, such as spray paint, calligraphy, 
crayon, and air brush. 

Eraser tool: Erase parts of an image. 

Rubber Stamp tool: Duplicate an area of an 
image. 

Color tools: 

Eyedropper tool: Sample a color from 
existing pixels. You can sample a 1-pixel, 
3-by-3, or 5-by-5 pixel area. The sampled 
color appears in all Stroke Color or Fill 
Color boxes throughout Fireworks.  

Paint Bucket tool: Change the color of 
selected pixels. 

Stroke Color box: Set the color of the 
outline of an object. 

Fill Color box: Set the color of the region 
inside an object. 

Three bottom icons: 

Set Default Stroke/Fill Colors: 
Automatically set colors for stroke and fill; 
defaults are black for stroke and white for 
fill. 

No Stroke Or Fill: A white box with a red 
line means there is no color (completely 
transparent). You cannot modify a stroke 
or fill with no color. 

Switch Stroke/Fill Colors: Swap the stroke 
and fill colors. 
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Property inspector 
The Property inspector displays options that change according to the current object or tool selection. Open a 
document, and the Property inspector displays document properties. Select a tool, and it displays tool options. Select 
a vector object, and it displays options such as stroke and fill. You can change these and other options right from the 
Property inspector. By default, the Property inspector is visible, but you can hide or show it by selecting Window > 
Properties. The following examples show the properties for a text object (Figure 2) and a rectangle shape 
(Figure 3). The options vary depending on the type of object or tool you have selected. 

 
Figure 2 Text Property inspector 

 
Figure 3 Rectangle shape Property inspector 

The first area on the left side of the Property inspector provides information about the selected object. You can also 
use this area to size or position the object on the canvas. 

Fill area: Change the fill color of a shape by clicking the color box in the second area of the Property inspector. You 
can select the fill type for a shape, such as solid, patterned, or dithered, from the menu beside the color box. This 
menu also provides various gradient effects. Other options include changing the type and amount of texture. 

Stroke area: Change the stroke category or color of a shape in the third area of the Property inspector. Change the 
tip size (thickness of the stroke) by typing a number in the text box beside the color box or by clicking the down 
arrow and then setting the slider. Select the stroke category, such as pencil, felt tip, or crayon, from the last menu on 
the right of the stroke area. Other options include changing the edge softness, the type and amount of texture, and 
the degree of corner roundness. 

Filters area: Add effects to objects by clicking the Add Live Filters button (the plus sign) in the last area on the 
right of the Property inspector. You can add filters to either the inside or the border of objects. Filters include glows, 
shadows, bevels, and color adjustments. Delete existing filters by selecting the filter and clicking the Delete Current 
Selected Live Filter button (the minus sign). After you select a filter from the menu, you can vary the opacity and 
blend mode. 
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How to build a nameplate 
To build a nameplate, you create a shape, add text, and then add effects to the shape and the text. You create the 
design by adding various effects and colors to the fill, stroke, and text. 

Build a nameplate 

1. Start Adobe Fireworks CS3, open a new document, and 
specify canvas dimensions (at least 400 pixels wide and 
200 pixels high). 

2. Save the file. 

3. Create a background for your nameplate by using the 
Rectangle tool in the Tools panel. Leave some white 
space on the canvas around the rectangle to add effects 
later. 

 The rectangle has small blue squares in the corner when 
you select it. 

4. Change the color of the stroke (outline) or the fill 
(inside) of the rectangle by using the Stroke Color box 
and the Fill Color box in the Property inspector (or the 
Tools panel). 

5. To add your name to the rectangle, select the Text tool 
in the Tools panel; then click and drag to draw a text 
box over the rectangle you just created. In the Property 
inspector, select the font, size, color, and style you want. 
Type your name. 

 (The example in Figure 1 uses Comic Sans MS, 32 pt, 
white, and bold.) 

6. To move your name around the rectangle, select the 
Pointer tool in the Tools panel, select the text object, and 
drag it to the desired position. 

7. To customize the look of the nameplate, select the 
rectangle or text; then click the Add Live Filters button 
in the Property inspector, select a filter, and select your 
settings.  

 You can also change the type of fill and stroke. 

 The illustrated nameplate uses a satin fill pattern and no 
stroke, with a feathered edge and grain texture for the 
rectangle (Figure 2). The text on the nameplate uses the 
drop shadow effect (Figure 3). 

8. After you complete all the desired effects, select 
Modify > Canvas > Trim Canvas from the main menu. 
This action removes any excess white space around the 
image. 

9. Save the nameplate. 

Figure 1 Text and rectangle  

 

Figure 2 Rectangle Property inspector 

 

Figure 3 Text Property inspector 
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How to create effects 
Effects in Adobe Fireworks CS3 apply to graphic objects and text objects, either to the interior of an object, to the 
border, or to both. Effects add dimension and contrast between the object and its background. You can find these 
effects in the Property inspector (Figure 1)—in the Filters area, the Fill area, and the Stroke area. Each effect has 
variables you can change to customize how the effect looks. The effects are described in the following sections. 

 
Figure 1 Property inspector 

Effects in the Filters area of the Property inspector 

Adjust Color 

• Auto Levels: Change the lightest to darkest pixel range, adjusting highlights, midtones, and shadows 
automatically. 

• Brightness: Make the object brighter or darker. 

• Contrast: Increase or decrease the distinction between light and dark. 

• Color Fill: Place another color on top of the object and change how transparent it is and/or how it blends with 
the original color. 

• Curves: Adjust any color along the tonal range (the light to dark spectrum) without affecting other colors. 

• Hue/Saturation: Adjust the color by allowing change of the purity and lightness of the color in the image. 

• Invert: Change the colors to the inverse color on the color wheel. For example, apply Invert to a red object to 
change its color to light blue. 

• Levels: Change the tonal range (the light to dark spectrum) by changing the number of pixels that are highlights, 
midtones, or shadows. 

Bevel 

Each of these filters has attributes to alter the beveled effect. You can alter the bevel’s color, the shape of the bevel 
edge (such as flat, smooth, or sloped), its contrast, its softness, and the angle of light that falls on it. 

• Inner Bevel: Give an object a three-dimensional look by making the inside of the object look lower than the 
outside of the object. 

• Outer Bevel: Give an object a three-dimensional look by making the inside of the object look higher than the 
outside of the object. 
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Emboss 

Emboss filters have attributes to alter the way the embossing looks. You can alter the image’s width, contrast, and 
softness and the angle of light that falls on it. 

• Inset Emboss: Make an image appear inset from its background. 

• Raised Emboss: Make an image appear raised from its background. 

Blur 

Blur the pixels in an image. 

• Blur: Soften the focus of selected pixels. 

• Blur More: Blur about three times as much as Blur. 

• Gaussian Blur: Apply a weighted average of blur to each pixel to produce a hazy effect. 

• Motion Blur: Create the appearance that the image is moving. 

• Radial Blur: Create the appearance that the image is spinning. 

• Zoom Blur: Create the appearance that the image is moving toward or away from the viewer. 

Noise 

The noise filter simulates the natural occurrence of image coloring being composed of pixels of many different 
colors. Noise refers to the random color variation of pixels that make up an image. You can apply color noise or 
monochrome noise. The amount of noise can be adjusted from 1 to 400, with an increase in amount resulting in 
more randomly placed pixels. 

Other 

• Convert To Alpha: Convert an object into a transparency based on the transparency of the image. 

• Find Edges: Change a bitmap to look like a line drawing by identifying the color transitions and changing those 
transitions to lines. 

Shadow and Glow 

These filters simulate different angles of light falling on the object. Each of these filters has attributes to alter the 
lighting effect. You can alter the color of a shadow or glow, the distance of a shadow from an object, the width of a 
glow, the opacity of a shadow or glow, its softness, the angle of light that falls on a shadow, or the offset of a glow 
from an object. 

• Drop Shadow: Make the object appear to be casting a shadow. 

• Glow: Make the object appear to glow. 

• Inner Glow: Highlight the object. 

• Inner Shadow: Darken the object so it looks as though something is casting a shadow on it. 

• Solid Shadow: Create a shadow streak in the shape of the object in any direction. 

Sharpen 

These filters correct blurry images. 

• Sharpen: Adjust the focus of a blurred image by increasing the contrast of adjacent pixels. 

• Sharpen More: Adjust the focus about three times more than Sharpen. 
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• Unsharp Mask: Adjust the contrast of the image edges to sharpen an image. This option offers the most control, 
so it is usually the best option for sharpening an image. 

Photoshop Live Effects 

You can apply some Photoshop layer effects using the Add Filters pop-up menu in the Property inspector. After you 
select Photoshop Live Effects, a dialog box appears. Select one of the effects in the left-hand pane of the dialog box, 
and then edit the settings in the right-hand pane. You can select multiple effects at once. The following Photoshop 
effects are available: 

• Drop Shadow 

• Inner Shadow 

• Outer Glow 

• Inner Glow 

• Bevel and Emboss 

• Satin 

• Color Overlay 

• Gradient Overlay 

• Pattern Overlay 

• Stroke 

Effects in the Fill area 
Fill effects alter only the inside of an object. These effects add texture to a shape. The Fill Category menu at the top 
of the Fill area includes the following options:  

• None: Use no color to fill an object. (Indicated in Color box by a red diagonal line.) 

• Solid: Fill an object with a solid color. 

• Web Dither: Approximate colors not in the current palette. 

• Gradient: Fill an object with colors or shades that gradually blend into each other. 

• Pattern: Create a textured pattern as a fill. 

Effects in the Stroke area 
Stroke effects alter only the stroke or outline of a graphic or text object. You can change the type of medium used to 
create the outline. Each medium has options such as the tip size, the texture of the ink, and the sharpness of the pen 
tip. Following are the mediums available: 

• Basic: Several types of pens. 

• Air Brush: Several types of air brushes. 

• Calligraphy: Several types of calligraphy pen tips. 

• Charcoal: Several colors and types of charcoal pens. 

• Crayon: Several types and colors of crayons. 

• Dashed: Several types of dashed lines. 

• Felt Tip: Several types of felt pens. 

• Oil: Several types of oil paint brushes. 

• Pencil: Several types of pencils. 

• Watercolor: Several types of watercolor brushes. 

• Random: Several types of elements surrounding the object (confetti, fur, dots, rectangles, yarn). 

• Unnatural: Several looks applied with multiple pens to the stroke of the object (3D, 3D Glow, Chameleon, 
Fluid Splatter, Outline, Paint Splatter, Toothpaste, Toxic Waste, and Viscous Alien Paint). 
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Nameplate interview 
Name: _______________________________________________________ Date:________________________ 

Name of student interviewed:_____________________________________________________________________ 

 

What Fireworks tools did you use to create your nameplate? (List below.) 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

What effects did you use? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

Describe, step by step, how you created your nameplate. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 
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Logo review and redesign 
Student name: _________________________________________________ Date:________________________ 

 

Answer the questions in each of the following categories, which will help you think about reviewing and 
redesigning your logo. 

• Meeting initial goals 

• Requiring new goals 

• Reflecting good design principles 

• Redesign changes 

Meeting initial goals 
What were your initial goals for the logo? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

Does the logo you have match the initial goals? Why or why not? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 
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Requiring new goals 
Do you have new goals in mind for the logo? If so, what are they and why? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

Reflecting good design principles 
What design concepts and principles did you originally incorporate into the logo? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

Are there new design concepts or principles you want to include in your logo? If so, what are they and why? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 
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Redesign changes 
What changes do you need to make to match your initial goals? Sketch or draw the changes in addition to writing 
about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

What changes do you need to make to account for the new design concepts and principles? Sketch or draw the 
changes in addition to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 
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How to create a page banner 
The purpose of a page banner is to establish a consistent identity on all pages so viewers know they are on a page of 
your website and recognize what the website is about. 

Create a page banner 

1. Start Adobe Fireworks CS3. 

2. Create a new file with dimensions at least 400 pixels 
wide and 100 pixels high. (Match your banner width to 
the pixel width of the web page you’re designing.) 

3. Turn on Guides and turn on Rulers from the View menu 
so you can align banner elements easily. 

4. Use the Rectangle tool or the Ellipse tool to create a 
background shape (such as a rectangle or oval) for the 
page banner. 

5. Add effects to the background shape. 

6. Add text to the banner. 

7. Add effects to the text, as you desire (Figure 1). 

8. Add images to your banner, as you desire. 

 The illustrations to the right show the effects used in the 
Property inspectors for the text (Figure 2) and the 
background ellipse (Figure 3) in the sample banner. 

9. Save the file. 

10. Export the file as a GIF or JPG image, depending on the 
level of color gradation or the presence of photographic 
elements in the banner. Use the 2 Up Preview or the 
4 up Preview to determine the best choices for exporting 
your image. 

Figure 1 Sample banner 

 

Figure 2 Text effects in sample banner 

 

Figure 3 Shape effects in sample banner  
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Page banner review and redesign 
Student name: _________________________________________________ Date:________________________ 

Reviewer name: _______________________________________________ 
 

Designer notes 

What were your initial goals for the page banner? 
 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  
 

Reviewer evaluation 

Does the page banner match the initial goals? Why or 
why not? 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 
 

What design concepts and principles did you incorporate 
into the page banner? 
 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  
 

Are there new design concepts and/or principles that 
could be included in the page banner? If so, what are 
they and why? 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 
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Designer notes 

How was each design concept intended to contribute to 
communicating the purpose of the page banner? 
 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  
 

Reviewer evaluation 

Do the design concepts chosen contribute to 
communicating the purpose of the page banner? Why or 
why not? 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 
 

Do you have new goals in mind for the page banner? If 
so, what are they and why? 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  
 

How might the new goals be incorporated into the page 
banner? 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 

____________________________________________ 
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Designer’s redesign 

What changes need to be made to match your initial goals? Please sketch or draw the changes in addition to writing 
about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

 

What changes do you need to make to account for the new design concepts and principles? Please sketch or draw the 
changes in addition to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 



Activity 1.11  worksheet  

4 Page banner review and redesign © 2007 Adobe Systems Incorporated 

What changes do you need to make to use the design concepts to better communicate the purpose of the page 
banner? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

What changes do you need to make to match your new goals and requirements? Please sketch or draw the changes 
in addition to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 
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Review and redesign presentation topics 
Here are some suggestions for organizing a presentation on redesign. 

• What did your original design look like? 

o Show original file. 

o Describe initial goals, design concepts, and requirements.  

• What was the reviewer’s evaluation? 

o What parts adhered to the original intent, goals, and concepts?  

o What parts didn’t adhere to the original intent, goals, and concepts?  

• What new ideas did the reviewer propose? 

o What is the redesign?  

o Show new page banner.  
 




